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Additional Tips

Additional Tips from Chapter 1

AX.01 Getting Help Samples

WINDOWS Alt,H, L
MENU Help | Samples
COMMAND Help.Samples
VERSIONS 2008,2010
CODE vstipEnv0002

This is another one of those things that is always there but that developers tend to forget
about. You can get sample code from within Visual Studio itself. Just select Help | Samples
from your menu bar.

What you see next is version-specific—for example, in Visual Studio 2010, you will see the
page shown below:

ey, -

URL: |C:\Program Files\Microsoft Visual Studio 10.0%3amplesh1033%Readhe htm v|

Microsoft: Visual Studio® 2010 Samples

Explore Wisual Studio samples to get up-to-speed quickly with the Visual Studio 20101

-

MSDMN Orling Samples

The most up-to-date sarnples are always available anline thraugh the ¥isual Studio 2010
Samples page.

Be sure to check back often for the latest updates to samples, along with new samples as
they are released!

Samples on Disk

Sarmples for Visual Basic, Visual C#, Visual C++ and more are available in local .zip files in
the location where you installed Visual Studio:

Mote: To build the samples, you must extract the .zip files to a folder to which you have
write access,

1. Selectthe .zip file containing the samples you want to open fram the local Samples
folder.

2. Right-click the .zip file and then click Extract All... to extract the sarmples to a folder of
your choice, such as My Documents or your Desktop.




A8 AX.02 Make the Start Page Go Away

Click the Local Samples Folder link, and you see the folder shown in the following image:

studio 2010 Samples

LJRL: |C:\Prograr‘n Files\Microsoft Wizual Studio 10.0%Samples\1033
MName : Date modified
. LanguageSamples 1/24/2011 9:55 PM
1) CSharpSamples.zip 3/19/2010 11:34 AM
£ | ReadMe.htm 9/30/2009 9:19 PM
1) TeamTest Samples.zip 3/19/2010 8:05 AM
1) VBSamples.zip 3/19/201011:34 AM
4y vca0105amples.zip 3/19/2010 11:34 AM

From here, you just unzip the code samples for the language you are interested in.

Ax.02 Make the Start Page Go Away

WINDOWS AltV, G
MENU View | Start Page
COMMAND View.StartPage
VERSIONS 2010

CODE vstipTool0002

Does the Start Page appearing every time you start Visual Studio annoy you? You can set up
Visual Studio so that the Start Page doesn't load when you start Visual Studio. Just look in the
lower-left corner, and clear the Show Page On Startup check box.

From now on, the Start Page shows up only when you want it to.

Close page after project load
[ Shows page on startup

Ax.03 Bringing Back the Start Page

WINDOWS AltV, G
MENU View | Start Page
COMMAND View.StartPage
VERSIONS 2010
CODE vstipTool0001

You might have noticed that when you open up a Solution or Project, the Start Page goes
away. This is the new default behavior in Visual Studio 2010.
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To change it, look in the lower-left corner of the new and improved Start Page, and clear the
Close Page After Project Load check box. From now on, the Start Page sticks around until you

close it yourself.

[7] Clase page after project load
Showr page on startup

Ax.04 Show All Settings with Visual Basic

WINDOWS
MENU
COMMAND
VERSIONS
LANGUAGES
CODE

Alt,T, O

Tools | Options
Tools.Options
2005, 2008, 2010
VB

vstipEnv0042

Did you choose the Visual Basic settings during your install?

55 General Developrnent Settings
1:3 Project Management Settings

5 Wisual Basic Developrnent Settings
[ Wisual C# Development Settings
[55 Wisual C++ Development Settings
[5 Wisual F# Developrnent Settings
[ Webh Development

I% Web Development (Code Only)

If so, you might notice, when you open the Tools | Options menu, that the options are not all
there:

Options

4 Environment
General
Fonts and Colors
Keyboard

> Projects and Solutions

» Text Editor

> Windows Farms Designer

To bring them back, just select Show All Settings at the bottom-left of the dialog box, and all
the available settings will reappear:
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AX.05 Find Your Development Settings

Options

4 Ervironment -
General
Add-infhdacros Security
AutoRecower
Docurments
Extension Manager
Find and Replace

m

Fants and Colars
Import and Export Settings
International Settings
Keyboard
Startup
Task List
Web Browser

» Projects and Solutions

» Source Control

» Text Editar

» Debugging

> IntelliTrace

Show all settings

AX.05

Find Your Development Settings

VERSIONS 2005, 2008, 2010
CODE vstipEnv0020

Development settings determine quite a bit when you use Visual Studio. For example, they
determine how you see the installed templates and what options you see initially in the
Tools | Options dialog box. You probably remember the following choices when you installed
Visual Studio:

[ General Development Settings
f% Project Management Settings

[5 Wisual Basic Development Settings
[ Wisual C# Developrment Settings
[ Wisual C++ Developrnent Setkings
55 Wisual F# Development Settings
55 Wieb Developrrent

55 Wieb Development (Code Only)

If you happen to forget what choice you made, you can quickly get a reminder by going to
the registry key HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\<version>\Profile.
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Warning Don't make any changes in the Registry for this tip; just view the data.

So, for Visual Studio 2010, the path would be HKEY_CURRENT_USER\Software\Microsoft\
VisualStudio\10.0\Profile, and then you would look at the “LastResetSettingsFile” string:

3_‘_'] LastResetSettingsFile REG_SZ Yavsspv_vs_install_directory®e\CommonT\IDE\Profiles\General wssettings

Assuming you haven't reset the settings via Tools | Import And Export Settings lately, this
value should have the name of the settings file you chose at first launch. In my case, as shown
in the preceding graphic, | chose the “General Development Settings” (General.vssettings)
option.

AX.06

Settings Automatically Saved On Exit

WINDOWS AltT, |
MENU Tools | Options | Import and Export Settings
COMMAND Tools.ImportandExportSettings
VERSIONS 2005, 2008, 2010

CODE vstipEnv0026

Visual Studio automatically saves your settings every time it is closed. To see where this file
is located (or to change the location), go to Tools | Options | Import And Export Settings and
locate the Automatically Save My Settings To This File area:

" Options o =)
4 Environment - | Autornatically save rry settings to this file:
General Wdocumentsiwisual studio 20100 settings\CurrentSettings.wssettings
Add-in/Macros Security
AutoRecover [] Use team settings file:
Dacuments Browse...

Extension Manager
Find and Replace

m

Fonts and Colors
Impaort and Export Settings
International Settings

The nice thing is that you can use this to “undo” any changes you have made during a ses-
sion. So if you made some changes to Visual Studio but don't want to keep them, you can
import the CurrentSettings.vssettings (default name) file to bring back your settings from the
last time Visual Studio was closed.
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AX.07 Customize Your Toolbars in Visual Studio 2008: Toolbars Tab

WINDOWS
MENU
COMMAND
VERSIONS
CODE

Alt,T, C

Tools | Customize
Tools.Customize
2008
vstipEnv0032

You can customize any toolbar in Visual Studio 2008. Just click the drop-down arrow to the
right of any toolbar, click Add Or Remove Buttons, and choose Customize:

bl L &) Sh =

|| &dd or Remowe Buttons =

Text Editar »

Customize...

Whichever option you choose opens the Customize dialog box:

Customize

Toolbars | Cammands

Toolbars:

[] Class Designer

(7] Context Mernus
Data Design
Database Diagram
Debug

Debug Location
Device

Dialog Editor
Formatting

Help

HTL Source Editing
Irmage Editor
Layout

kenu Bar

FEOEEEEEEEEEL

wewis i New..

Rename..,

m

Delete

[] Use large icons
Show ScreenTips on toolbars

Show shortcut keys in ScreenTips

’ Keyboard.. ] [ Clase ]
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Custom Toolbars

Notice that the Toolbars tab lists all the available toolbars. When you click New to create a
customized toolbar, you are prompted to give the new toolbar a name:

Custornize @
Toolbars | Commands

Toolbars:

e - New...
Class Designer I
g::ati)x:s[i\ginus Mew Toolbar Al Rename...
Database Diagram | Tgalbar name:
Debug

Debug Location
Dewvice

Dialog Editor [
Formatting
Help
HTHL Source Editing

Image Editor

Layout

henu Bar =

Delete

Ok ] ’ Cancel ] Reset

50 o e

[T Use large icons
Showe ScreenTips on toolbars

Showe shortcut keys in ScreenTips

’ Keyboard.., ] ’ Close ]

After you name it, you can delete the custom toolbar by clicking Delete, or you can rename it
by clicking Rename:

Custornize @
Toalbars | Commands

Toolbars:

Recorder - o
Report

Report Borders
Report Formatting
Source Contral
Standard Delete
Style &pplication
Style Sheet Reset
Table Designer i
Test Tools
Text Editor
Wiew Designer
Workflow

Renarme...

Bl

m

AL Editor

5 o = o e

[] Use large icons
Showe ScreenTips on toolbars

Showe shortout keys in ScreenTips

’ Keyboard... ] ’ Close
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Additionally, you can take advantage of the following options at the bottom of the dialog
box:

e Use Large Icons Shows larger icons on toolbars in your environment.

e Show ScreenTips On Toolbars
items:

@3

[Find in Files (Ctrl-+Shift+F)}

Indicates whether you see a tooltip for the toolbar

e Show Shortcut Keys In ScreenTips Shows the shortcut key combinations in the
tooltips for items that have them.

“ Debug

Start Debugging (F5] |

- Ay

Clicking the Keyboard button at the bottom of the Customize dialog box is just the same as
going to Tools | Options | Keyboard (see vstipTool0063, “Keyboard Shortcuts: Creating New
Shortcuts,” on page 127 for details):

Optians @
a Environment - Apply the following additional keyboard mapping scheme:
General | (Default) v] l Reset I
Add-infMacros Security
AutoRecaover Show cormrmands containing:
Documents

Find and Replace ;

d
Fants and Colors ActionAdd METFrameworkLaunchCondition (]
Help ActionAddAction i
Action.AddDialog S
4| I +

m,

Import and Export Settings
International Settings

>
5 Source Contral

» TextEditor

> Business Intelligence Designers
> Database Tools

Keyhoard Shartcuts for selected comrnand:
Startup 4 Rernove
Task List
Wieb Browiser Use neww shortcut ing Press shartcut keys:
Projects and Solutions Global = Assign

Shortcut currently used by
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Customize Your Toolbars in Visual Studio 2008: Commands Tab

WINDOWS
MENU
COMMAND
VERSIONS
CODE

Alt,T, C

Tools | Customize
Tools.Customize
2008
vstipEnv0033

You can customize any toolbar in Visual Studio 2008. Just click the drop-down arrow to the
right of any toolbar, click Add Or Remove Buttons, and choose Customize:

bl L3 &) 5h =

| Add

of Rermowe Buttons = | Text Editar »

Customize...

Alternatively, you can go to Tools | Customize on the menu bar. Whichever option you
choose opens the Customize dialog box:

Customize

HOOOOEEEEEEEmE

Toolbars | Carrnands

Toolbars:

L - New...

Class Designer
Context Menus
Data Design
Database Diagram
Debug

Debug Location
Device

Dialog Editor
Formatting

Help

HTL Source Editing
Irmage Editor
Layout

tenu Bar

Renarne...

m

Delete

[] Use large icons
Showe ScreenTips on toolbars

Showe shortcut keys in ScreenTips

’ Keyboard... ] [ Close ]
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In this case, let’s look at the Commands tab:

Note To learn more about the Toolbars tab, see vstipEnv0032, “Customize Your Toolbars in
Visual Studio 2008 Toolbars Tab,” on page A12.

Customize @
Toalbars | Cornrnands
Categories: Commands:

L] Add MET Frarmework Launch Condition -
Addins ¥ . ¥
Build Add Action ‘E|
Class Diagrarn L Add Assernbly e
Cub i
D:tae Add Custom Action
Diata Source Wiew | Add Dialog
Database . -

Database Diagram Add File Launch Condition

Debug Add File Search

Dimension .

DSl Tools Add File Type

Edit Add Internet Information Services Launch Condition

File Add Launch Conditian

Faormat

Help Add Registry Launch Condition =
Image 2

Modify Selection Rearrange Commands..
To add a command, drag the command frorn the Commands list and drop the command on the target
toolbar or menu,

’ Keyboard.., ] [ Clase ]

The best way to learn how to customize menus and toolbars is to work through an example.

For our purposes, we want to add the ability to select some code, right-click, and comment
or uncomment the code.

First, we have to go back to the Toolbars tab and pick the menu or toolbar we want to modi-
fy. For our example, let's choose Context Menus:

Editor Context Menus = Class Wiew Context henus »

Customize
Toolbars | Cormmands
Toolbars:
[T Build
[] Class Designer
IZ s
|| Data Design
[] Database Diagram
[[]Cebug
[[] Debug Location
(IRl S,
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Now we click the Commands tab and locate the items we want to add. In this case, we dig a
bit and find Selection Comment and Selection Uncomment in the Edit category:

Customize @

Toolbars | Comrands

Categories: Commands:

Dimension = Selection Capitalize =
DEL Tools = ;

B SieciznConuiel

File |2 | Selection Formnat

Format .

Help Selection Lowvercase

Irnage Selection Swap Anchor

Insert = ;

Layout Selection Toggle Case

Macros 2 | Selection Uncomment

Mining Model e .

nien Selection Uppercase

Project Showe Grid l__.l
Query Designer )| Show Member List T
Refactar

Report Show Snippet Highlighting -
Report %

Modify Selection » ’ Rearrange Commands...

To add a cammand, drag the command from the Comimands list and drop the command on the target
toolbar or menu.

[ Keyboard... ] [ Close

Now we have to see which menu we want to modify. Let’s navigate to Editor Context Menus |

Code Window to see where we want our items to go:

|Edit0r Context Menus = | Class Wiew Context Menus ~ Debuc

| [ Code Window >|

HoML Editor - »

‘' tu AL A

BB o 2=

Refactor »
Drganize Usings 3
Insert snippet

Surround With

Go To Definition

Go To Reference

Find &Il References
Breakpaint 3
Run To Cursor

Cut

Copy
Paste

Outlining 3
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Now we drag the items where we want them on the menu:

|Edit0r Context kenus - | Class View Context Menus  Debugger (

Code Window » Selection Comment

105 1

HAML Editor  » | Selection Uncomrent |
Refactor v
Organize Usings 4
&, | Insert snippet
El | Surround With
3 | Go To Definition

B | GoTo Reference

Find &Il References
Ereakpoint 3
Run Ta Cursar

Cut

Copy
Paste

g8 i 2 %

Outlining 3

If we want, we can click Modify Selection to reset, delete, modify the name, modify the but-
ton image, change the way the item is displayed, or begin a new group:

Modify Selection + ’ Rearrange Comrmands...

Reset fram the C

Delete

Mame: Selection Uncamrment
o Copy Button Image

Paste Button Image

Reset Button Image

Edit Button Image..,

Change Button Image 3

Default Style

Text Only (Shways)

Text Only {in Menus)

Image and Text

Begin a Group
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We would like the new buttons to be in their own group, so we click the item just below
where we want our group to be:

| Editor Context Menus | Class Wiew Context Menus ~ Debugger

Code Window »
HAML Editar »

Selection Comment

TiEITl

Selection Uncomment

| Refactor M 3

DOrqanize Usli,r\'f.gs 3

Insert snippet
Surround With

48 | Go To Definition

Now we click Modify Selection and choose Begin A Group to get a new group line:

‘|Editar Cantext Menus | Class Wiew Context Menus > Debugger

Code Window »
HAML Editar »

Selection Comment

Selection Uncamment

W5 1l

Refactor I}? 3

Drganize Usings 3

Insert snippet
= | Surround With

I

Go To Definition

Close the Customize dialog box, select some code, and right-click to see whether our items
show up:

Comment election

15 i

Uncomment Selection
Fefactor 3
Organize Usings 3

Create Unit Tests...

Insert Snippet..,
Surround With,.,

+ TR
P ik

Gao To Definition
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AX.09 Hide or Show Default Buttons on a Toolbar

Hide or Show Default Buttons on a Toolbar

VERSIONS 2005, 2008, 2010

CODE vstipEnv0028

You can pick and choose which default buttons you want to show on any toolbar. Just click
the drop-down arrow to the right of the toolbar:

Then click Add or Remove Buttons:

PR %% % [0 B REAETH] =

. & Mew Test,.. Add or Remowve Buttons -
] 'a[> Run Tests in Current Context Ctrl+R, T F
% Run &l Tests in Solution Ctrl+R, &

% Alllmpacted Tests Ctrl+F,
Debug Tests in Current Cormtext Ctrl+R, Ctrl+T
Debug &l Tests in Solution Ctrl+R, Ctrl+4
All Impacted Tests Ctrl +R, Ctrl+Y
Test Wiewr

Test List Editor

Test Results

Code Coverage Results
Test Runs

TestImpact Wiew

m@adHEEae s D

Show Code Coverage Coloring

. 4

Go to previous uncovered

e e e B e e e e e A S e e N S Y S

Go to next uncovered

+

Custamize..,
Reset Toolbar

As you can see, this gives you a list of the buttons currently being viewed. You can uncheck
some of them to create a customized look for your toolbar:
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=

v Eaj Tewny Test.,,

v

Test Wiew
Test List Editor
Test Results

Test Runs

<
M@ dHEOaas s & &

Customize..,

Reset Taalbar

All Impacted Tests

TestImpact Wiew

All Impacted Tests

a-.b Fun Tests in Current Contest Ctrl+R, T
Fun &Il Tests in Solution Ctrl+R, A

Ctrl+R, %

Debug Tests in Current Context Ctrl+R, Ctrl+T
Debug &l Tests in Solution Ctrl+R, Ctrl +2

Ctrl+R, Ctrl+Y

Code Coverage Results

Show Code Cowverage Coloring
Goto previous uncovered

Go to next uncovered

Add or Rermove Buttons -

Unfortunately, if you have added customized buttons, they can’t be hidden in this way:

Add or Rermove Buttons =

vleMain(s

e LY S

Build Solution
List Mernbers m
Pararmeter Info
Quick Infa
Complete YWord

%O e Gl EF

A21

AX.10

Reset Toolbars

VERSIONS
CODE

2005, 2008, 2010
vstipEnv0029

You can reset any toolbar to its default settings. Just click the drop-down arrow to the right
of any toolbar, and then click Add or Remove Buttons:



A22 AX.10 Reset Toolbars

P % PR | RREERB| = -

. & Mewr Test., Add or Fermowve Buttons -

‘;'b Run Tests in Current Contesxt Ctrl+R, T

% Run &Il Tests in Solution Ctrl+R, 2,

“. Alllmpacted Tests Chel +R,
Debug Tests in Current Context Chrl+R, Ctrl+T
Debug &1 Tests in Solution Crl +F, Crl+4,
Al Impacted Tests Chrl+R, Ctrl+Y%
Test Wiew

Test List Editar

Test Results

Code Coverage Results

Test Runs

Test Impact Wiew

Show Code Coverage Coloring

i+

Goto presious uncovered

AL SIS SIS TS SIS SIS IS S SIS IS S

+

Go to next uncowered

Custarmize..,

Reset Toalbar

Click Reset Toolbar:

¥ By TestImpactiew

¥ = ShowCode Cowverage Colating
v |:= 5o to previous uncovered

v &= (o tonextuncovered

Customize..

Reset Toolbar

You now see the following dialog box:

Microsoft Visual Studio X1

I.-"'_"\-. Are you sure you want to reset the changes made to the 'Test Tools'
L - 4 toolbar?

Yes || Ne

Click Yes to remove any custom buttons and to reset the toolbar to its default settings.
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Note In Visual Studio 2008, you have to go through an extra menu to get to the Reset Toolbar

Additional Tips from Chapter 2

AX.11

Sorting Templates in the New Project Dialog Box

DEFAULT
VISUAL BASIC 6
VISUAL C# 2005

VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS
MENU
COMMAND
VERSIONS

CODE

Ctrl+Shift+N

Ctrl+Shift+N; Ctrl+N

Ctrl+Shift+N

Ctrl+Shift+N

Ctrl+Shift+N

Ctrl+N

Alt,F, N, P (new project); Alt,F, D, N (add new project)
File | New Project; File | Add New Project
File.NewProject; File.AddNewProject
2010

vstipProj0003

Ever just want to have an alphabetical list of templates in the New Project dialog box? Just
use the new Sort By drop-down list:

New Project

(-2l

Recent Templates [,NET Framework 4

~ | Sort by: [Default

| Search Installed Templat @ ‘

Installed Templates

4 Visual Basic
Windows

Va| Windaws Forms Applicatio

Web _th WPF Application

Default
: Wisual Basic

Name Descending oject for creating a cormmand-line

application
Visual Basic

A23
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AX.12 Toggle Icon Size in the New Project Dialog Box

Toggle Icon Size in the New Project Dialog Box

DEFAULT
VISUAL BASIC 6
VISUAL C# 2005

VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS
MENU
COMMAND
VERSIONS

CODE

Ctrl+Shift+N
Ctrl+Shift+N; Ctrl+N
Ctrl+Shift+N
Ctrl+Shift+N
Ctrl+Shift+N

Ctrl+N

Alt, F, N, P (new project); Alt, F, D, N (add new project)
File | New | Project
File.NewProject
2005,2008,2010
vstipProj0007

When you create a new project (or add a new item) in Visual Studio, you can change the icon
size from small to medium (called /arge in Visual Studio 2008). To do this, you need to find
the buttons that change the icon to your desired size and then click them. Unfortunately,
these buttons appear in different places, depending on your Visual Studio version. In Visual
Studio 2010, for example, the buttons are located toward the middle-right of the New
Project or Item dialog box, next to the Sort By field:

[.NET Framewark 4

~ | Sort by: | Default

| Search Installed Tem J@ |

g'cﬁ Windows Forms Application  Visual C#

&M WPF Application

Small Icons
Type: Vi
A project for creating an application with a
Windeows Forms user interface

Wisual C#

In Visual Studio 2005 and Visual Studio 2008, the buttons are at the far right, as shown in the

following illustration:

L5 [

BEE

ﬂ,,‘ECIass Library
@Wimlows Cantral Library
58 ASP.MET Web Applicatian

Large Icons i
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Choosing the StartUp Project

A25

WINDOWS

MENU

COMMAND

VERSIONS

CODE

Alt,P, A (with project selected in Solution Explorer);
Shift+F10, A (with project selected in Solution Explorer)

Project | Set as StartUp Project;
[Right-Click a project in Solution Explorer] | Set as StartUp Project

Project.SetasStartUpProject
2005,2008,2010
vstipEnv0014

When you work with multiple projects, one is usually the StartUp Project. That's the one

that starts up first when you start (with or without debugging). It's easy to spot the current
StartUp Project because its name appears in bold type in Solution Explorer:

Solution Explorer

= 2R

=

; Solution 'ConsoleApplication22’ (2 projects)
] _Z*ﬂ CaonsoleApplication22

» [=d] Properties
» i References
#] Pragram.cs

4 Z*ﬂ ConsoleApplication23

» [=d Properties
» i References
#] Pragram.cs

To quickly change the Startup Project, just right-click

choose Set As StartUp Project from the context menu:

‘Solution Explorer

=@ S

> I X

; Solution "ConsoleApplication22' (2 projects)

4 E Consale&nnlication??

P Build

> I Rebuild
ol

c‘;(— Clean

4 L q

. B % Publish...

> (2 Run Code Analysis
ol

Project Dependencies...

Calculate Code Metrics

Project Build Qrder...

Add

Add Reference..,

Add Service Reference...

336 View Class Diagram

Set as StartUp Project

a project in Solution Explorer and
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AX.14 Linked Items in Projects

Linked Items in Projects

DEFAULT Shift+Alt+A; Ctrl+Shift+D
VISUAL BASIC 6 Ctrl+D; Shift+Alt+A
VISUAL C# 2005 Shift+Alt+A

VISUAL C++ 2 Shift+Alt+A
VISUAL C++ 6 Shift+Alt+A
VISUAL STUDIO 6 Shift+Alt+A; Ctrl+Shift+D
WINDOWS Alt, P, G
MENU Project | Add Existing Item
COMMAND Project.AddExistingltem
VERSIONS 2005,2008,2010
CODE vstipProj0022

You sometimes have a shared resource that you want to include in your project. Traditionally,
you would add the existing item (Shift+Alt+A), and Visual Studio would make a copy for you.

However, did you know you can just link to the item instead? You would typically do this
if you had a shared resource on, say, a network drive that you want to include but don't
want to have a copy in your project. To do this, go to the Add Existing Item dialog box
(Shift+Alt+A) and choose Add As Link from the Add drop-down list.

File name: Readme tst - |AiFiles 1) -
[ Add |v] [ Cancel l
Add
Add &s Link

Now a link to the file is added to your project rather than a copy:

Solution Explorer

=S (E
; Solution 'ConsoleApplication2?’
4 [ ConsoleApplication22
=d| Properties
] References
] Program.cs
) Readme bt

You can tell a file is a link because it has an arrow indicator in the icon, as shown in the pre-
ceding graphic—much like the arrow you see on shortcut icons in Windows. The usual cave-
ats apply here, just as they do to any shortcut. For example, for Visual Studio to use the file,
you need to make sure that the path to the linked file is accessible.
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Using the Miscellaneous Files Project

WINDOWS AltT, O
MENU Tools | Options | Environment | Documents
COMMAND Tools.Options
VERSIONS 2008,2010
CODE vstipProj0012

Did you know that Solution Explorer can display a Miscellaneous Files project for files that
you do not want to permanently associate with a project or solution? Maybe you still want
to track and be able to open certain files quickly—but not associate them with the project or
solution. For example, you can create and edit files by using the Visual Studio editors without
creating a project. You can also work on files that you want to use temporarily—such as files
in which you keep development notes while you work on your solution.

To get the Miscellaneous Files folder to show up, go to Tools | Options | Environment |
Documents and select the Show Miscellaneous Files In Solution Explorer option:

Options
4 Environment P [ Reuse current document window, if saved
General [¥] Detect when file is changed outside the environment
Add-in/Macros Security [] Auto-load changes, if saved

AutaRecover [V] Allow editing of read-anly files: warn when attempt to save
Dacuments § i . i
Extension Manager [¥] Open file usmg. (I|rect?ry of .:.urrer'ltl:,r active document
Check far cansistent line endings on load

m

Find and Replace

Fants and Calors Display warning when global undo will modify edited files

Impaort and Expart Settings [¥]iShow Miscellaneous files in Solution Explarer:
International Settings 0 items saved in the Miscellaneous files project
Keyboard

Pay particular attention to the Items Saved In The Miscellaneous Files Project field, which is
initially set to zero. Leaving this value set to zero shows only extra files you currently have
open; however, setting it to another number indicates how many files you want to remember
at any given time. If you aren't sure about what this value should be, to get started, | suggest
setting this value to at least five.

Note The Miscellaneous Files Project does not show up until you open up at least one file that
goes in it.
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After you open a file that doesn't belong to the solution, the folder shows up, as shown in

the following illustration:

Solution Explorer

; Solution 'ConsoleApplication22' {1 project)

4 (3 ConsoleApplication22
> [=dl Properties
» [«3] References
#] Pragram.cs
4 2 Miscellaneous Files

=5 ConsoleApplication22.suo

With the folder now showing, you can right-click and open, create, or remove files:

Note Removing files from this folder doesn't delete them permanently.

4 |0 Miscellaneous Files
1 MewFile..
Lj Open File...
#£ Cut
Paste
Remove

X
Properties

Ctrl+M
Ctrl+0
Ctrl+X
Ctrl+V
Del
Alt+Enter

Ax.16 Change the Order of Your Application Settings

VERSIONS
LANGUAGES
CODE

2008,2010
C#,VB
vstipProj0024

When working in your project properties, you might sometimes find yourself using a variety
of application settings (I'm assuming you know how to create and use application settings;
if not, you can find more information at http.//msdn.microsoft.com/en-us/library/a65txexh.

aspx):


http://msdn.microsoft.com/en-us/library/a65txexh.aspx
http://msdn.microsoft.com/en-us/library/a65txexh.aspx
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Resources
MName Type Scope WValue
Servi
BV BackgroundCal... | System.Dra... | |User - .l}, 51, 204
Settings® FaregroundColar |System.Dra... |= |User - .204, 102, 153
Reference Paths Path string | Application hd |.-\--\stuﬂ
WindowCalar System.Dra... | |User - .255, 80, 80
Signi
'ging SettingsMame string w |User ¥ |Bubba's Stuff
Security [ Setting string ¥ |User -

But what if you want to organize these settings? For example, suppose you want the
WindowColor setting to appear with the other color settings. You can change the sequence
to your preference.

Warning Changing a setting requires you to manually edit your settings file—which could get
you into trouble if you make a mistake, so do this at your own risk. Also, make a copy of your set-
tings file before editing it so that you can recover if a problem occurs.

First, save any pending changes, and close the Properties window. Now open up the project
location:

m A save Program.cs Ctrl+5
m Close Ctrl+Fd
usin Close All But This
usin
usit Copy Full Path
Open Containing Folder
T Eamf Float

= Dock as Tabbed Document

Locate your Properties folder:

s | %« Proje.. » CSharpWindowsFarmsApplication » v|d'r,|

Organize « 3 Open Include in library = Sharewith = » &=

-

Marme Date maodified Type
! bin 6/20/201L 303 PM File folder
. abj 6/29/2011 3:03 PM File falder
| . Properties 6/29/2011 3:03 PM File falder

=
Pk

= app.config 9/2011 3:09 PM KL Canfir
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Locate your Settings file, named Settings.settings in this example:

E=8 EoR ==
w| . = CSharpWindowsFormsApplication » Properties - |+ Search Pro.. 2 [
L P PP [ +
Organize v [=”] Open with... E-mail Burn New folder ==« [ IZEZI
-
MName Date maodified Type Size
#] AssemblyInfo.cs 6/29/2011 3:03 PM Visual C#
#] Resources.Designer.cs 6/29/2011 3:03 PM Visual C= Sa
_:J Resaurces.resx 6/29/2011 3:03 PM MET Mana
#] Settings.Designer.cs 6/29/2011 3:09 PM WVisual C
| Settings.settings 6,/29/2011 3:09 PM Wisual Stuclio Setti

Open the Settings.settings file with a plain text editor such as Notepad. Notice that the file is
an XML file:

M_w| Settings.settings - Motepad EI@

File Edit Format Wiew Help

<?7xm] wersion="1.0" encoding="utf-8'7 .
<SettingsFi1e xmins="http: schemas.n
<Profiles />
<Settings»
<5etting MWame="BackgroundColar™ 1
<value profile="{Defaultl"=0,
</getting>
<Setting nWame="Foregroundcolor” T
<value pProfile="(Defaultl"=204,
</Setting>
<Setting Name="Path" Type="Systen
<value profile="(oefaultl"s=. .M.
</Setting>
<setting Name="windowColor" Types
<value profile="{Dpefaulti">2559,
</setting>
<Setting nWame="settingsname” TyEE
<value profile="(Dpefault)">Bubk
</Settings
< /Settings>
</settingsFiles

n

As you see in the preceding illustration, each setting resides in a <Setting> element. You just
need to rearrange the elements in the order you want them. In this case, select the <Setting>
element whose name attribute is WindowColor, as shown in the following illustration:
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r

ﬁ Settings.settings - Motepad EI@

File Edit Format View Help

<?7xm] wersion='1.0" encoding="utf-8'7 .
<settingsFile xmlns="http://schemas.n
<profiles />
<settingss
<Setting Wame="Backgroundcolor" 7
<value pProfile="(Default)">0, ¢
< /settings
<Setting MWame="ForegroundZolor" 7
<value profile="(Default)">204,
< /Settings
<Setting Mame="Path" Type="sSystan
<value Profile="(Default)">. .M.
< settings

ting Mame="settingsnName" Ty
<value pProfile="(pefault)">BuU
< /Settings
</settings>
</SettingsFiles

b

Next just cut and paste it where you want the setting to show up. For this example, place it
just after the ForegroundColor <Setting> element:

H Settings.settings - Motepad EIIEI

File Edit Format Wiew Help

<7xm] wersion='1.0" encoding='utf-8'% .
<settingsFile xmins="http://schemas.n
<Profiles />
<sertingss
<Setting Mame="BackgroundColor"” T
<value profile="(Default)">0, ¢
</Settings>
<Setting MName="ForegroundCaolar™ 1
<value profile="(oefaultl)"=204,
< /Settings>
<setting Mame="windowColor" Types
<value profile="{Defaultl">2559,
</setting>
<Setting Mame="Path" Type="Systen
<value profile="(Default)"=. ..
< /Settings
<Setting Mama="sSettingsMama" TyEe
<value profile="{oefault)"=Buhk
</Setting>
</Settingss>
< /SettingsFiles
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Save your changes and close the file. Now, when you go back into your Project properties,
you'll see the settings arranged in their new order:

Resources
MName Type Scope Value
Servi
- y RSN System.Dra... | v [User - [l 5. 204
Settings ForegroundColor | System.Dra... User - .204_ 102, 153
Reference Paths WindowCalor Systemn.Dra.. User - .255_ 80, 80
Path string Application | = [\ \stuff
Signing Settingshame string User ~ |Bubba's Stuff
Security * -

Ax.17 Hide or Show the Solution File in Solution Explorer

WINDOWS
MENU
COMMAND
VERSIONS
CODE

AltT, O

Tools.Options
2005,2008,2010
vstipProj0008

Tools | Options | Projects and Solutions | General

If you don't like seeing the solution file in Solution Explorer, you can easily hide it (or show it
if you have it hidden). First, take a look at the default view of Solution Explorer, with the solu-

tion file showing:

Solution Explorer

=N

4 [ €SharpWindowsFormsApplication
» = Properties
= [+3] References
= app.config
» =] FormLes
#] Pragram.cs
#] Settings.cs

;; Solution "CSharpWindowsF armsApplication’

To hide the solution file, select Tools | Options | Projects And Solutions | General, and clear

the Always Show Solution option:

Show acdvanced build configurations
[C] Akways show solution
Save new projects when created
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The result is shown below:

Solution Explorer

= 2R

.z CSharpWindowsFor msApplication

> [Zd Properties

2 [53] References
i3 app.config

> =] Formles
#] Program.cs
#] Settings.cs

Note This feature works only when you have just one project in the solution; if you have mul-
tiple projects in your solution, Visual Studio ignores this setting and shows you the solution node.

A33
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New Project Dialog Preferred Language

WINDOWS
MENU
COMMAND
VERSIONS
CODE

AltT, I

Tools | Import and Export Settings
Tools.ImportandExportSettings
2005,2008,2010

vstipEnv0041

As you're examining items that Visual Studio can export, you might come across the New
Project Dialog Preferred Language option, under General Settings:

Which settings do you want to export?

EIRIEIRIE]

Find Optians -
Find Symbal Options

Menu and Command Bar Customizations
Mew Project Dialog Preferred Language

Description:

Specifies the organization of the folder
nades in the Mew Project dialog.

Object Browser Options

You might wonder what that means. The best way to explain is to show you a little bit more
about the inner workings of Visual Studio.
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When you installed Visual Studio, you might recall having chosen your preferred develop-
ment settings:

[5% General Development Settings
[Z5 Praject Management Settings

[Z5 Visual Basic Development Settings
[Z5 Visual C# Develapment Settings
[Z5 Visual C++ Development Settings
ff& Visual F= Development Settings
|E'_q Web Development

|:f& Web Development (Cade Only)

Some of these options are language-specific, and some are not. If you chose General

Development Settings, for example, you have no preferred language in the New Project dia-
log box, so you see a list of languages:

Mew Project

Recent Templates

Installed Templates

Visual Basic

Visual C#

Visual C++

Visual F#

Other Project Types
Database

Modeling Projects

Without a preferred language, the New Project dialog box groups all the language-specific
templates into separate nodes, so you can easily select the one you want. However, if you
chose a development setting option associated with a particular language, such as VB, you
see something different in the New Project dialog box:

Mew Praject

Recent Templates

Installed Templates

Visual Basic

Other Languages
Other Project Types
Database

Modeling Projects
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As you can see, the other top-level language nodes have disappeared, because you already
indicated that Visual Basic is your preferred language. Instead, you'll see an Other Languages
node that represents all the other languages:

Mew Project

Recent Templates

Installed Templates

Visual Basic
4 Other Languages

Visual C#
Visual C++
Visual F#

Other Project Types

Database

Maodeling Projects

Test Projects

So, to come full circle, when you export the New Project Dialog Preferred Language item, it
saves this structure for you, which you can then later import.

AX.19 Optimizing Your Project Code

DEFAULT Alt+Enter (with project selected in Solution Explorer)
VISUAL BASIC 6 Alt+Enter (with project selected in Solution Explorer)
VISUAL C# 2005 Alt+Enter (with project selected in Solution Explorer)

VISUAL C++ 2 Alt+Enter (with project selected in Solution Explorer)
VISUAL C++ 6 Alt+F7; Alt+Enter (with project selected in Solution Explorer)
WINDOWS Alt,P, P
MENU Project | [Project Name] Properties
COMMAND Project.Properties
VERSIONS 2008,2010
LANGUAGES C#,C++, VB
CODE vstipProj0014

In vstipDebug0032 ("Understanding Just My Code,” page A215), we touched on optimiza-
tion. When optimization is turned off (the default setting for Debug builds), it factors into
the code being considered “yours” for the purposes of determining what is “Just My Code.”
Generally, you won't turn this on for Debug builds. If you do, debug symbols are not gener-
ated and you can't step through your code.
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When you create a Release build, Visual Studio turns optimization on by default. So what is
optimization? According to the documentation, the optimization option “enables or disables
optimizations performed by the compiler to make your output file smaller, faster, and more
efficient.”

It's useful to know where to find this option.

C#
In C#, you'll find the Optimize Code option in the Project properties on the Build tab:

Application
Caonfiguration: |Active (Debug)
Bunld”
Platfarm: | Active (46)
Build Events
G I
Debug enera
Resources Conditional compilation symbals:
Define DEBUG constant
Services
Define TRACE canstant
Settings

Platform target:

Reference Paths
[T] Allow unsafe cade

Signing Optimize code

VB

In VB, it is also in the Project properties, but on the Compile tab, and you need to click
Advanced Compile Options to find it:

Application

Canfiguration: ’Active {Debug) -
Campile
Debug [T] Disable all warnings
Reforenery [] Treat all warnings as errors
Generate XML documentation file
Resaurces
Services

4l

’ Advanced Compile Options...




Appendix B Additional Tips A37

Next, locate the Enable Optimizations option:

Advanced Compiler Settings
Optimizations

[] Remove integer overflow checks Enable aptimizations

C++

While VB and C# have only a single option to control optimization, C++ supports a number
of more specific optimizations. For example, you can choose to optimize for application
speed or for program size. Enabling the optimizations setting from the Project properties en-
ables full optimization (/Ox).

You can get a sense of the full range of /O features in the following list at http://msdn.microsoft.
com/en-us/library/klack8f1.aspx:

e /Ol optimizes code for minimum size.

e /O2 optimizes code for maximum speed.

e /Ob controls inline function expansion.

e /Od disables optimization, speeding compilation and simplifying debugging.

e /Og enables global optimizations.

e /Oi generates intrinsic functions for appropriate function calls.

e /Os tells the compiler to favor optimizations for size over optimizations for speed.

e /Ot (a default setting) tells the compiler to favor optimizations for speed over optimiza-
tions for size.

e /Ox selects full optimization.

e /Oy suppresses the creation of frame pointers on the call stack for quicker function
calls.

Finally

Optimization does a lot of cool things that are great for a shipping application—but not for
one you are currently working on and debugging. It's easy to get deep into what the various
optimization options actually do; Eric Lippert, of Microsoft, wrote an excellent article on this
subject, titled "What Does the Optimize Switch Do,” which you can find at http://blogs.msdn.
com/b/ericlippert/archive/2009/06/11/what-does-the-optimize-switch-do.aspx.


http://msdn.microsoft.com/en-us/library/k1ack8f1.aspx
http://msdn.microsoft.com/en-us/library/k1ack8f1.aspx
http://blogs.msdn.com/b/ericlippert/archive/2009/06/11/what-does-the-optimize-switch-do.aspx
http://blogs.msdn.com/b/ericlippert/archive/2009/06/11/what-does-the-optimize-switch-do.aspx

A38 AX.20 Full Screen Mode

Additional Tips from Chapter 3

AX.20 Full Screen Mode

DEFAULT Shift+Alt+Enter
VISUAL BASIC 6 Shift+Alt+Enter
VISUAL C# 2005 Shift+Alt+Enter

VISUAL C++ 2 Shift+Alt+Enter
VISUAL C++ 6 Shift+Alt+Enter
VISUAL STUDIO 6 Shift+Alt+Enter
WINDOWS AltV, U
MENU View | Full Screen
COMMAND View.FullScreen
VERSIONS 2005, 2008, 2010
CODE vstipEnv0024

You can quickly switch from any current window state to Full Screen Mode by pressing

File Edit View Website Bulld Debug Tesm Data Tools Architecture Test Anshae Window Help (3 FullScreen
Deloultospe %
Cllent Oblects & Events T (o Evenss) ]
X Fage Title"Rome Page” Language="Ve" FastersageFiiee"n/Site Master” AutoEventireupsTalse” &
CodeFile-"Detault.aspx.vb” Inherits="_Detault” % ,
casp:Content To="HeaderContent* runats"server® ContentPlaceHolderIDs"Headcontent™>
»
To="RadyCantrat " CantentPlaceoldes -
lielcone to ASPLHET!
/2>
<
To learn more obout ASP.NCT vizit <o href-"http://mei.03p.nct” title-"ASP.NT Hebsite"»waw.03p.ncte/os.
o
Pae
Vou can alse Find <a href- i /ulink/ L inkT0-
“itlesHSON ASS.NET Docs”sdacumentation on ASPLNET At WSOH</3> 3
<]
</nsp:Contents
s - i 5
1000 [ fp | @ somee || | xpeneamostycamens i

By default, this action hides the toolbars and takes up as much of the screen as possible. The
advantage, of course, is that you get more real estate to work with when you need more
room.

To come out of Full Screen Mode, just press Shift+Alt+Enter again and you are returned to
normal view.
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Ax.21  Split Your Windows Horizontally

WINDOWS Alt,W, P (toggle split and remove)
MENU Window | Split; Window | Remove Split
COMMAND Window.Split (toggle split and remove)
VERSIONS 2005, 2008, 2010
CODE vstipEnv0004

A39

In Visual Studio, you can split your windows horizontally. This feature has been available in
Microsoft products for quite a while. Just go to Window | Split on the menu bar, or you can

use the following mouse technique.

Go the upper-right corner of a document window, and look for the splitter control, as shown

in the following illustration:

N
=
-

a

Click and drag the control down to begin the split process:

Now you have a horizontal split, so you can do things like see different sections of your

document at the same time:

Client Objects & Events | (Mo Events) -
<%@ Page Title="Home Page” Language="VB" MasterPageFile="~/Site.Master” AutoEventiireup="false”
CodeFlle="Default.aspx.vb™ Inherits="_Default” %>

<asp:Content ID="HeaderContent” runat="server” ContentPlaceHolderID="HeadContent™>
</asp:Content>
Sl<asp:Content ID="BodyContent” runat="server” ContentPlaceHolderID="MainContent”>

=] <h2>
Welcome to ASP.MNET!
3 </h2>
= epr
To learn more about ASP.NET visit <a href="http://www.asp.net” title="ASP.NET Website">www.asp.net
<in> -
1%~ | [ »
—

<@ Page Title="Home Page” Language="VB" MasterPageFile="~/Site.Master” AutoEventiireup="false"
CedeFile="Default.aspx.vb" Inherits="_Default" %>

<asp:Content ID="HeaderContent™ runat="server” ContentPlaceHolderID="HeadContent™>
</asp:Content>
El<asp:Content ID="BodyContent” runat="server” ContentPlaceHolderID="MainContent”>

n

= <h2>
Welcnme ta ASP_NFT!
</h2>
=) <p> L4
To learn morc about ASP.NET vizit <a hrof="http://ww.asp.nct” title="ASP.NET Wcbsitc™>www.asp.nct
3 </p>
El <p>

You can also find <a href="http:
title="MSDN ASP.NET Docs”>documentation on ASP.NET at MSDN</a>.

</p>
_</asp:Content>

0%~ «| m »
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To remove a split, select Window | Remove Split—or just double-click the line separating the
two sections.

AX.22 Sorting Items in the Toolbox

WINDOWS Shift,F10, O (with the Toolbox selected)
MENU [Right Click the Toolbox] | Sort Items Alphabetically
COMMAND Tools.SortltemsAlphabetically
VERSIONS 2005, 2008, 2010

CODE vstipTool0052

® Warning As far as | know, there is no easy way to undo the sorting action other than resetting
the Toolbox, so make sure you really want the Toolbox items listed alphabetically before you ap-
ply this tip.

If you don't like the default sort order for items in the Toolbox, you can right-click the
Toolbox and then choose to sort the items alphabetically:

Button | |I

& Cut Ctrl+X

53 Copy Ctrl+C

4 Paste Ctrl+V

X Delete Del
Renarme Item

List View
E% Show All
Choose Items...
= Sort Itermns Alphabetically
A Reset Toolbox
Add Tab
Move Up

X

Move Down

Selecting this option sorts the items by name, assuming they weren’t sorted that way already:
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5 AdRotator
:= BulletedList
Button

m Calendar
CheckBox
E=  CheckBoxList
DropDawnList
ty  FileUpload
bl HiddenField
A Hyperlink
@ Image

AX.23 lcon vs. List View in the Toolbox

WINDOWS Shift,F10, L (with the Toolbox selected will toggle List View)
MENU [Right Click the Toolbox] | List View (toggle)
COMMAND Tools.ListView
VERSIONS 2005, 2008, 2010
CODE vstipTool0053

The default view of items in the Toolbox is List View, as shown in the following illustration:

Toolbox v @1 X
4 Comman WPF Cantrals
Kk Pointer
iZi  Barder
Buttan
CheckBax
& ComboBox
& DataGrid
1 Grid
B Image
A Label
EE  ListBox

You can change this to the Icon View if you prefer, by right-clicking the Toolbox and clicking
List View, which turns off the List View option:
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Toolbox > 0 X
4 Common WPF Contrals
k  Painter
BPirelar

Cut
Copy
Paste
Delete

i 8

X £

Rename Item

<

List View
Show All

PEAEWE EED

This produces the result shown in the following illustration:

Toolbox - 0¥
4 Common WPF Controls

Ak O @M= &M

EADE

(Al
To get the List View back again, right-click in Icon View, and click List View again.

This option applies only on the current Toolbox tab, so you can have your tabs organized dif-
ferently based on your preference:

Toolbox * I

4 Common WPF Cantrols o
kO B &
M= AE®O

B o [Al
4 AllWPF Contraols
k  Painter
IO Border =
Button
m Calendar
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AX.24 Hide the Status Bar

WINDOWS AltT, O
MENU Tools | Options | Environment | General
COMMAND Tools.Options
VERSIONS 2005, 2008, 2010
CODE vstipTool0024

Removing the Status Bar gives you a little extra space at the bottom of your screen. Without
it you cannot get status messages, so remove it only if you are sure you don't need it. To re-
move the Status Bar, go to Tools | Options | Environment | General and clear the Show Status

Bar option:

[ Shaw status bar

Before (status bar is where the word "Ready” is located):

F_fc_; Error List [B OQutput

Ready

After (no status bar):

Ienu

F_f,_; Error List B Cutput

AXx.25 Remove the Navigation Bar

WINDOWS AltT, O
MENU Tools | Options | Text Editor | [All Languages or Specific Language]
COMMAND Tools.Options
VERSIONS 2005, 2008, 2010
CODE vstipTool0028

If you find you don't use the navigation bar, shown in the following illustration, and want a
little extra space, how can you make it go away?

M MainWindowxaml.cs X BEERRERE

I Aw ‘pfApplicationl. MainWindow I % MainWindow()
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Just go to Tools | Options | Text Editor | [All Languages or Specific Language], and clear the
Navigation Bar check box:

[ Mavigatian bar

The following illustration shows the result:

MainWindow.xaml.cs >

—lusing System;
using System.Collections.Generic;

Ax.26 Show Any Toolbar

WINDOWS Alt,V, T, [Up or Down] Arrow
MENU View | Toolbars | [Toolbar]
VERSIONS 2005, 2008, 2010

CODE vstipEnv0025

You can show any toolbar at any time. Just right-click an existing toolbar, and left-click the
one you want to see:

- EH- 20 b [Debug ~| |x86
Architecture Designers
Build

Class Designer
CodeCormnpare
CodeCompare Layout
Custom 1

Data Compare

Data Design

Data Generator

Database Diagram

Not all toolbars will have their buttons available, because it depends on your context. For
example, the Database Diagram Toolbar (shown in the following illustration) buttons are not
available until you are actually working on a diagram:

File Edit View Refactor Project Build

R IEE TR
P 3738 | R 22| 55| 7 ab | TableV
[ New Table p (2 [ 4R &8 | = 2 [

Ul MainWindowaxaml.cs 3 EEEREEtT

ki
(i
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Ax.27 Changing Auto-Hide Behavior for Tool Windows

WINDOWS
MENU
COMMAND
VERSIONS
CODE

Alt,T, O

Tools | Options | Environment | General
Tools.Options

2005, 2008, 2010

vstipTool0035

By default, you could easily have several tool windows in a tab group, as shown here:

Solution Explorer

2EEE
= WpfApplicationl
> [=d Properties
> gl References
> = Apposaml
>

| MainWindow.aml

> I X

£ Solution E...

So to clear your workspace, you click the auto-hide button:

Lo
~ L%

Auto Hide

Now all the tool windows are hidden together. Next you can go to Tools | Options |
Environment | General and select the Auto Hide Button Affects Active Tool Window Only

option:

Auto Hicle button affects active toal window anly

Now you no longer get tabs at the bottom when you interact with a tool window:

A45
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Solution Explorer > 1 X
Bl E

.E WpfApplicationl

> [=d Properties

s [+3] References

> [ Appaaml

> | MainWindowoaml

The tool windows have to be docked individually to get the tabs again:

Solution Explorer * I X

iallE

.E WpfApplicationl

» [=d] Properties

» i References

> [ Appaaml

> | MainWindow saml

l?f"; LU 5 Find and R... E® Class View

Now, when you auto-hide a window, only that window is hidden; the rest of the tab group
remains visible:

Class View
v

| -

Ci| = =

|<Search> '| kd =4
> | WpfApplicationl

3oe[day pue puly & §

‘a Solution Explorer JERSuEHRNTN




Ax.28 Closing a Tool Window Tab Group

WINDOWS
MENU
COMMAND
VERSIONS
CODE

Shift,Esc

Tools | Options | Environment | General
Window.CloseToolWindow

2005, 2008, 2010

vstipTool0040
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By default, when you click the Close button for a tool window in a tab group, it normally
closes only the current tool window:

Solution Explorer

=N e

> [=d Properties
> 3] References
> = Appsaml
>

.= WpfApplicationl

| MainWindow.aml
=

* 0[x

Close

£ Selution E...

However, you can change this behavior by going to Tools | Options | Environment | General
and clearing the Close Button Affects Active Tool Window Only check box, as shown in the
following illustration:

[7] Clase button affects active taol window only

Now, closing any one tool window in the tab group causes all tool windows in that group to

be closed.

Ax.29 Copy and Paste with the Command Prompt

WINDOWS Enter (copy)

MENU System Menu | Edit | [Mark, Copy, Paste, Select All]

CODE vstipTool0057

In a previous tip, we looked at how to work with the command prompt history. In this tip, we
examine how to copy and paste text to and from the Command Prompt window.
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Pasting

Visual Studio offers a rich set of tools to help you work with text in the command prompt
windows. For example, you can copy text and paste it by going to System Menu | Edit | Paste,
as shown in the following illustration.

Note The System menu is the icon in the upper-left corner of the window.

BN Visual Studio Command Prompt (2010}
t for using Microsoft Uisual Studio 2818 x86 tools.

Restare
Move icrosoft Visual Studio 18.8~UC>Some cool text_
Size
- Minimize

o Maxdmize

x Close
Edit 3 Mark
Defaults Capy Enter

Properties Paste
Select All

Serall

Find...

If you have a folder or file path you want to use, you can always find the folder or file in
Windows Explorer and drag the item to the command prompt, as shown in the following
illustration:

|

BEA Visual Studia Cammand Prampt (2010}
Setting environment for using Microsoft Uisual Studie 2018 x86 tools.

1] 01_93 vstipToel0 120 Classic Help in Visual Studio v4_C
1] 9._04 vstipEnv02L Exporting Your Environment Settin
1] 01_95 vstipToeld002 Make the Start Page Go Away v4 |
] 01_06 vstipToeld00 L Bringing Back the Start Page v4_(|

IC-\Program Files\Microsoft WUicual Studioc 10.0NUC>

) 91_07 vstipTaol0d 17 Remove Projects from the Recent
o105
) 1_09 vstipEnv0042 Show All Settings with Visual Basic
e n e amene o

ipToel0025 Visual Studio Tip of the Day Start

<

ﬂj ] 01_05 vstipToold002 Make the Start Page

The preceding action pastes the full path to the folder or file in the window:

E® Visual Studio Command Prompt {2010}
Setting environment for using Microsoft Uisuwal Studio 2818 xB6 tools. ~

IC:“FProgram Files“Microsoft Uisual Studio 18.8~UC>"D: \Document.,\ol’l9111y Book~ChaplE
ter 1%01_B5 vstipToolB@BA2 Make the Start Page Go Away v4_CE.doc"



Copying

You can copy text from the command prompt by marking the text. Go to System Menu |

Appendix B Additional Tips

Edit | Mark, as shown in the following illustration:

& Visual Studio Command Prompt (2010)

Restore
Move
Size
= Minimize
o Maximize
x  Close

Edlit
Defaults

Properties

Mark

Copy Enter
Paste

Select All

Scrall

Finel...

Highlight the text you want by clicking and dragging over that text:

B Select Visual Studio Command Prompt (2010}

HAN ST SR icrosoft Uisual Studio 10. B8

If you want, you can always go to System Menu | Edit | Select All:

EX Select Visual Studio Command Prompt (2010}

Restare
Maove
Size
= Minimize
o Maamize
x  Close

Edit

Defaults

Properties

Press Enter to copy the text to the clipboard, and then paste the text where you want.

icrosoft Uisuwal Studio

Mark

Capy Enter
Paste

Select All

Scrall

Find...

A49
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Ax.30 Customize the Command Prompt

WINDOWS Alt,Space, P

MENU System Menu | Properties

CODE vstipTool0058

If you are going to use the command prompt, you might want to customize the look and
feel:

B Visual Studio Command Prompt (2010)
Setting environment for using Microsoft Uisuwal Studio 2818 x86 tools.

C:“\Program Files“Microsoft Uisual Studio 18_8~UC>_

Note If you want to customize the Command window, you need to run it as Administrator. To
do this, just right-click the command prompt icon and choose Run As Administrator:

Visual Studio Command Prampt
{2010}

Open
« Micrasa -
| A Run as administrator

w Microsao Pin to Taskbar

Unpin from Start Menu
ah /) Paint
Remaove from this list

(e Internet Praperties

Let's review some basic settings you might want to take advantage of early on. First go to
System Menu | Properties:



B Visual Studio Command
Restore
Mave
Size
- Minimize

o Maxamize

x  Close
Edlit »
Defaults

Properties

Note Just as a reminder, the System menu is the icon at the upper-left corner of the window:

Visual Studio Command Prompt (20 10)

C:“Program Files“Microsoft Uisual

Options

On the Options tab, notice that we have several items of interest:

B "Visual Studio Command Prompt (2010)" Properties

Options | Font | Layout | Colars

Curzor Size

Small
@ hedium

Large
Command History Edit Dptions
Buffer Size: 100

Murnber of Buffers: 23 | Inzert Mode

| Digcard Old Duplicates

V| QuickEdit Mode

X3

Appendix B Additional Tips
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AX.30 Customize the Command Prompt

Cursor Size

Represents the size of the flashing cursor.

Small

B Visual Stuclio Command Prompt (2010}

c: \Windows \System32>_

Medium

B Visual Studio Command Prompt (2010}

c:“UWindows“\Systend2iy

Large

Bl Visual Studio Command Prompt {2010}

c:\Windows\Systen32>]]

Command History

Deals with how many commands are remembered by setting the buffer size (number of com-
mands to remember) times the number of buffers. The default is 200 commands, but this
value can be changed to 999 for each value for a max total of 998,001 commands that can
be remembered. | usually set Buffer Size to 100 and Number Of Buffers to 5, for a total of

500 commands remembered.

| usually select the Discard Old Duplicates option. Some people leave this off for running the
same command several times, so you might want to leave this off in some cases. Selecting
this option removes duplicates so that they don’t show up several times in the command

history.
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Before:

B Visual Studio Command Prompt (2010) EI@

c:~Windows \System32>_

: ed ..Nsystem332
:cd ..Nsystem32
= cls

: dir

I cmcls

L==-El- g NN E)

After:

B Visual Studio Command Prampt (2010}

C:xWindows \System32>_

B: cd “Windows“Systemn32
iE.E§!.......ii..................

Edit Options

Define how you can do certain actions. Quick Edit Mode allows you to use your mouse to
work with text in the window, so | suggest you turn it on. Insert Mode is on by default and
simply means that if you move the cursor into a command (using the arrow keys), you can
type and it inserts (instead of overwrites) the text after it.
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Before:

B Visual Stuclio Command Prompt (2010}

C:\Windows“8ysteml2netstat pe

After:

B Visual Studio Command Prompt (2010}

C:UWindows“Systemn32>netstat —p tct me

Font

The Font tab is pretty self-explanatory. It allows you to pick various font properties for the
command window. Play with these to suit your needs:

BEX "Visual Studio Command Prompt (2010)" Properties @

Optionz | Font | Layout | Colors

whindow Preview Size

12 -

=]
=
m

Fatt Bold forts
T Consolas
L

R aster Fonts
Selected Font : Lucida Conzole

R Each character iz:
C - \WI NDOWS> 14 zcreen pivels wide
SYSTEM 24 screen pizels high

|l ok | | Cancel
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Layout

The Layout tab is very important. Let's look at some of these options:

BN "Visual Studio Command Prompt (2010)" Properties @

Layout | Colo

Window Preview

Screen Buffer Size

Width: 1o =
Height: Foon =
Window Size

Width: an 5
Height: 25 $

‘Wwindow Pozition
Left: 42
Top: 267

| Let spztem position window

Screen Buffer Size

Allows you to set how wide and tall you want the window information to be. Width should

be less than the window size width you anticipate. Because | tend to maximize my command
windows, | set this to 100. Height is how many lines you want to be able to scroll back to. | set
this to 5000 just because | like large buffer sizes. Most folks tend to set this to around 1000
or so.

Window Size

Sets the initial size of the command window. You can play with these settings to find a suit-
able size for you. Because | maximize my command windows, | just leave this setting alone.

Window Position

The position you want the window to start in. | would leave this setting be, but if you want to
change it, set Left and Top to 0 and then increase from there to suit your taste.

Colors

The Colors tab allows you to change two major aspects of the color scheme for the com-
mand window: one for the regular window and one for the pop-up window you get when
you press F7:
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B "Visual Studio Command Prompt (2010)" Properties @

Options I Fant I La_l,lc-ut| Colors |

Screen Text Selected Color Walues

3 1B Bed: 0 =
_) Popup Test Greer: 0 =
! Popup Background Blue: 0 P

LI |

Selected Screen Colors

CsUINDOWS > dir
<DIR> 10-81-99

<DIR> 10-81-99
T

DICOTL 4 @A_iAd _aa

Selected Popup Colors
C:\WINDOWS> dir

SYSTEM <DIR> 18-81-99 L
SYSTEM32 <DIR> 18-81-99 L
DCHTIMT TVT DAL A RA_A4d a0 C =i

[ ak. ] [ Cancel ]

These settings are completely personal preferences, so try adjusting them and looking at the
previews at the bottom to determine what schemes suit you. | tend to favor the old school
“green screen” colors on my Command windows (green text with a black background).

Resetting Back to Defaults

If you totally mess up your settings, you can always get all the default settings back by going
to System Menu | Defaults:

B Visual Studio Comman
Restore
Mowve
Size
- Minimize

o Maximize

x  Close
Eclit 3
Defaults

Properties
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After clicking Default, you see the properties with all tabs set to their default settings. Just
click OK, and you have all your defaults back:

Console Windows Properties IEI

Optiors | Furt I Layout I EDIDIS|

Curzar Size

@ Small

() Medium

() Large

Command History Edit Options

Buffer Size: 50 = [T QuickEdit Mode
MHurnber of Buffers: 4 z Inzert Mode

[ Digzard Old Duplicates AutaComplete

Note When you restore the default settings, notice the AutoComplete option that wasn’t en-
abled before. This option allows for tab completion of file names. (See vstipTool0056, “Command

Prompt Tab Completion,” page 105.) You should always leave this setting on.

AX.31 Show All Toolbox Controls

WINDOWS
MENU
COMMAND
VERSIONS
CODE

Shift,F10, S (with Toolbox selected)
Right-click | Show All
Tools.ShowAll

2005, 2008, 2010

vstipTool0060

Sometimes when you install controls for the Toolbox, you might not see the controls because
they are in the wrong context. For example, a WPF control wouldn’t show up in the Toolbox
while you are typing code. When the controls don’t show up, you might think the add-in
failed to install the Toolbox controls. This tip shows how you can confirm everything installed

in the Toolbox.

To see all the controls that are installed, right-click the Toolbox and select Show All, as shown

in the following illustration:
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AX.32 Server Explorer: Data Connections

Toolbox

4 General

There are no usable controls in this
group. Drag an item anta this text ta

additto] "% Paste
v List View
Show All

= B W MainWindow.xaml.cs 3

Ctrl+V

Now all the controls are visible, regardless of context:

Toolbox *
> Windows Workflow v3.0
> Standard
> Control Flow
4 Common WPF Caontrols
Paointer
Baorde
Button
CheckBa

CambaoBa

X

a~

m

AX.32

Server Explorer: Data Connections

DEFAULT
VISUAL BASIC 6
VISUAL C# 2005

VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS

MENU
COMMAND
VERSIONS

CODE

Ctrl+Alt+S (view server explorer)

Ctrl+Alt+S (view server explorer)

Ctrl+Alt+S; Ctrl+W, L; Ctrl+W, Ctrl+L (view server explorer)
Ctrl+Alt+S (view server explorer)

Ctrl+Alt+S (view server explorer)

Ctrl+Alt+S (view server explorer)

Alt,V, V (view server explorer); Alt,T, D (connect to database)
View | Server Explorer; Tools | Connect to Database
View.ServerExplorer; Tools.ConnecttoDatabase

2005, 2008, 2010

vstipTool0121

Server Explorer (Ctrl+Alt+S) is the server management tool window that comes with Visual
Studio. One of the things you can use this window for is to open data connections:
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Server Explorer * 1 X

EIRENRE
a [ Data Connections
> [ apollo.Morthuind.dbo
2 |1k apollo.pubs.dbo
> [ Database Diagrams
> [ Tables
s [ Wiewws
» [ Stored Procedures
= [ Functions
> [ Synonyms
> [ Types
» [ Assemblies
> 24 Servers
> gHl SharePoint Connections

Data Connections in Other Areas

The data connections you have in Server Explorer can be used in other areas, such as ADO.
NET Entity Data Models:

Entity Data Model Wizard -7 |z

! J_T_‘/ Choose Your Data Connection

Which data connection should your application use to connect to the database?

apollo.Narthwind.dbo - MNew Cannection...

apollo.Naorthwind.dbo

apollo.pubs.dbo

When you go to create Entity Data Models that are generated from a database, you can
choose from the data connections you already have or you can create a new connection to
be added to the list.

Data Connections in Server Explorer

There is an incredible amount of power and control that is available here. Let's look at a
couple of examples.
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Tables

-SewerEprUrer > I X

2] | T | gy
4 [ Data Connections
> |k apolle.MNaorthwind.dba
4 || apollo.pubs.dbo
> [ Database Diagrams
4 [ Tahles
. [ authors
. [ discounts
. [ employee D&
- [ jobs
. [ pub_info
. [ publishers
- [ roysched
o [ sales
. [ stores
. [ titleauthar
. [ titles
s Wiewws

At the most basic level, you can list out the tables in the database. Additionally, you can
right-click any table and see most of the features you can leverage, as shown in the following

illustration:
4 [ Tables I
» | authnrs
- diss Ld Mew Table
» Eem Compare Data
> B job Add Mew Trigger
» [ put
. put Mewe Juery l:&
== | roy Open Table Definition
» [ sals [§  Show Table Data
. sto| .
= C Ctrl+C
. [ title = LoRy n
. [ title X Delete Del
[ Views | [#] Refresh
> O Stored ‘=) Properties Alt+Enter
+ [ Functic:
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Notice that you can add a new table, create a new query, or just show the data in the table,

among other tasks.

Stored Procedures

s Wiewws
4 [ Stored Procedures
o [2] byroyalty
- [Z] reptgl
o [Z] reptg?
- [Z] reptg3

- [ Functions

One of the great database features in Visual Studio is that not only can you create and edit

stored procedures, but you can step into them as well:

s Wiews
4 [ Stored Procedures
o 2] byrovalty
s ; rep Add Mew Stored Procedure
o [Z] rep 5 open
) jrep Execute Chrl+8)t+F5
> [ Functig
. £ Synom Step Into Stored Procedure L\\T Alt+F5
> [ Types | 53 Copy Crl+C
> [ Assem| ¢ Delete Del
T4 Servers
gHi SharePoint Co E Refresh
LE Properties Alt+Enter
| |
Finally

Don't take the Database Connection features in Server Explorer for granted. These features
make a great deal of power available to you, and you should invest some time to see whether

these are helpful for your work.
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AX.33 Server Explorer: Server Event Logs

Server Explorer: Server Event Logs

DEFAULT
VISUAL BASIC 6
VISUAL C# 2005

VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS

MENU
COMMAND
VERSIONS

CODE

Ctrl+Alt+S

Ctrl+Alt+S

Ctrl+Alt+S; Ctrl+W, L; Ctrl+W, Ctrl+L
Ctrl+Alt+S

Ctrl+Alt+S

Ctrl+Alt+S

AltV, Vv

View | Server Explorer
View.ServerExplorer
2005, 2008, 2010
vstipTool0122

Most people believe that Server Explorer is the tool window we use for data connections (see
vstipTool0121, “Server Explorer Data Connections,” page A58), and they assume that's pretty
much where the experience ends.

This unsung hero really does a lot more if you let it. For example, the Servers section comes
with a power that you might not even know existed—working with servers.

Adding Servers

To get started, Server Explorer comes with the local machine already in the list of Servers,
plus you can add additional servers as needed:

Server Explorer > 0x

2] | T
> [ Data Cannections
a |54 Servers

> 3 apolle 2]
> gHl SharePoint|

Refresh
Delete Dl
Add Server...

= Properties Alt+Enter

Don't be fooled by the term “Server”; it really means any computer that you want to connect
to for information. In these examples, my “server” is a Microsoft Windows 7 Professional—-
based machine.
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Event Logs

After you have the server that you want, you can start working with features. The Event Logs
section is a perfect example. The following illustration shows what is on my machine for
Event Logs in Server Explorer:

Server Explorer v I X

FIRERRE
» [ Data Connections
a4 |24 Servers
a & apollo
a i1 Eventlogs
- i3] ACEEwventlog
- i8] Applicatian
» 5| Hardware Events
» @IntemetExplorer
» 5 Key Managernent Service
+ 15| Media Center
- 5| Microsoft Office Alerts
- 5] Security
- i Systern
3 gi_?j Windows PowerShell
- 2y Management Classes
> [ Management Events
. _3 hessage Quedes
» 4] Performance Counters
. ¥ Services

> gHl SharePoint Connections

You can use this area to start the Event Viewer if you need it:

4 T4 Servers

4 M apollo
4 |3 Event Logs

#] Refresh
X Delete Drel
Launch Event YWiewer

Properties Alt+Enter

= |
o 38| Microsoft Office Alerts
- 8 Security

Or you can take a quick view of events in any of the various categories by drilling down into
the tree:
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4 3| Application Errar ‘
& 61972011 7:15:48 AM - Faulting appli—
@ 4/8/2011 9:09:16 PM - Faulting applic
@/ 3/25/201101:31 AM - Faulting application narne: ... |
@ 11/30/2010°10:15:00 PM - Faulting ap
@ 1173042010 10:13:26 PM - Faulting ap
@ 1173042010 10:13:17 PM - Faulting ap
& 9/25/2010 6:17:43 PM - Faulting appli
@ 92572010 6:17:32 PM - Faulting appli

Click and Drag Components

Event log components can even be dragged onto a Windows form or component class de-
sign surface so that you can manipulate them:

Note For more information, see the topic “"How to: Add Items from Server Explorer,” at http.//
msdn.microsoft.com/en-us/library/84s2c1k0.aspx.

Server Explarer = 1 X} CornponentLcs [Design]* X

2] | %
> [ Data Connections
a4 T4 Servers

eventlogl

4 4 apollo
4 3| EventLogs
> 8] ACEEventlog [
- 5 Application ofe]

- 8] Hardware Events

> 3] Internet Explarer

- 3] Key Management Service
3 gﬁj hdedia Center

- i8] Microsoft Office Alerts

> 8 Security

s Qj System

> 8] Windows PowerShell

When the component is in place, you can write code to perform various actions. In the fol-
lowing example, an entry is written to the event log:

public void WriteTolog()

{
eventLogl.WriteEntry("Log entry!");

This is a great way to have event log information available to the user. Taking time to learn
Server Explorer can definitely bring you benefits in your daily work.


http://msdn.microsoft.com/en-us/library/84s2c1k0.aspx
http://msdn.microsoft.com/en-us/library/84s2c1k0.aspx

AX.34

Server Explorer: Server Management Classes

DEFAULT
VISUAL BASIC 6
VISUAL C# 2005

VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS
MENU
COMMAND
VERSIONS

CODE

Ctrl+Alt+S

Ctrl+Alt+S

Ctrl+Alt+S; Ctrl+W, L; Ctrl+W, Ctrl+L
Ctrl+Alt+S

Ctrl+Alt+S

Ctrl+Alt+S

AltV, Vv

View | Server Explorer
View.ServerExplorer
2005, 2008, 2010
vstipTool0123
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The management classes in Server Explorer give you a view into the system. For example, you
can use management classes to see network shares, as shown in the following illustration:

Server Explorer > 1 X

2] 1| T 4
> [ Data Connections
a  F3 Servers
4 M apollo
+ i3 Event Logs
a2y Management Classes
3 :ﬁ Desktop Settings
» =3 Disk Wolurmes
- My Computer
8 Metwork Adapters
» 52 Metwork Connections
+ 5| NT Event Log Files
+ ] Operating Systerns
(54 Printers
- O Processes
. 4@ Processars
. ¥ Services
a L1 Shares
LA Default share{CH
ke HP Officejet 15700 series
» L Printer Drivers{print®)
> 21 Remote Adrmin(aDMING
» LA Remote IPCIPCE)
» bl Users
> % Software Products (MED
- [ System Accounts
» 4Z} Threads
» [ Management Events
> _3 Message Queues

+ 4] Performance Counters | 4

»

m
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Create
You can also right-click a node and choose Create from the menu to make a new instance:

b Services
2 |23 Shares|

[#] Refresh

K Delete Del
Create Mew Object..,

Generate Managed Class

| Create..
Pl e by
b Properties Alt+Enter
b 45 Threads

b # Managernent Everts
[ g Message Queues

Unfortunately, you get a really ugly and unfriendly dialog box to use when you do this, as
shown in the following illustration:

Server: AFOLLO

Input Parameters:

Mame | Type | alue -
b coess) abject E
Description string

b airmurmdlloweed Lint32

M ame string ¥
i m | »
Results:

MName | Type |Value

Returmtalues Lint32

[].4 ] l Cancel
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Generate Classes
One better way to work with the management classes is to right-click one and then generate
a class from the menu:

48 Processors
o | Services
© | [#] Refresh
: X Delete Del
s Create Mew Object.,
N Generate Managed Class L\\—y
’ '3 Create..,
: ﬁ Properties Alt+Enter
g4 SharePoint Connections

This gives you a class you can use as you see fit:

‘Solution Explarer * 1 X
2RI EE &S
; Solution 'C5 Clean Console’ (1 project)
4 [ C5 Clean Console
> [=d| Properties
> [ag] References
. ] Coamponentlcs
] Program.cs
] ROOT. cirmw2 Wiin32_Service.cs

// Private property to hold the WMI namespace in which the class resides.
private static string CreatedWmiMamespace = "ROOT\\cimv2";

// Private property to hold the name of WMI class which created this class.
private static string CreatedClasshName = "Win32_ Serwvice”;

Click and Drag Components
The management classes can also be dragged onto a Windows form or component class de-
sign surface so that you can manipulate them.

Note For more information, see the topic "How to: Add Items from Server Explorer,” at http.//
msdn.microsoft.com/en-us/library/84s2c1k0.aspx.


http://msdn.microsoft.com/en-us/library/84s2c1k0.aspx
http://msdn.microsoft.com/en-us/library/84s2c1k0.aspx

A68

AX.35 Window Layouts: File View

Server Explorer ~ 1 X8 ComponentLcs [Design]* Xm

T I
2] L o :
) Data Connections - ‘iﬁsharel ‘iﬁsewicel

4 54 Servers
4 & apollo
i3] Event Logs
4 3y Management Classes
3 :_;fj Desktop Settings
= Disk Volurnes
4 My Computer
a4 [F8 Metwork Adapters
123 [00000000] WAN Miniport (SSTPHD)
|28 [00000001] WAN Minipaort IKEw2)(1)
[ [00000002] WAN Miniport (L2ZTPMZ)
[Z8 [00000003] WAN Miniport (PPTP(3)
[ [00000004] WAMN Miniport (PPPOE)(4)
|28 [00000005] WAN Miniport PwE)(5)
|28 [00000006] WAN Miniport (Metwork Mon
|28 [00000007] Realtek PCle GBE Farnily Cont
|28 [00000008] WAN Minipart IP(8)

m

AX.35

Window Layouts: File View

VERSIONS 2005, 2008, 2010
CODE vstipEnv0053

| talked about the different window layouts in vstipEnv0051, “Window Layouts: The Four
Modes,” on page 90, and vstipEnv0052, “Window Layouts: Design, Debug, and Full Screen,”
on page 91. Now | want to cover a lesser-known layout known as File View.

You get to File View by putting in the file name of any file associated with Visual Studio at the
command prompt. In the following example, I've changed my directory to one of my solu-
tions, and I'm putting in the name “SomethingToDo.cs™:

B8 Visual Studio Command Prompt {2010 E@

d:\DocumentsVisual Studio 2818“Projects“Consolefipplication22>SomethingTolo.cs

| »

d:\Documents*\Uisual Studio 2018“Projects-Consolefipplication22>

When | tried to do this without running the command prompt as Administrator, it wouldn't
load the file. So you might have to run the command prompt as Administrator. If Visual
Studio is already open, it shows the file and if not, it loads and shows the file:
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58 SomethingToDo.cs - Micrasoft Visual Studio e e e |
File Edt View Project Debug leam Data lools Architecture lest Anslyze Window Help

ig-a-SHd| % ano-o-8-8| m || @E R
R S Z2|088ME3asd iU es HMRY3RE0Z R 2,

SomethingTeDo.cs X
using System; +|
using system.collections.Generdc; F
using System.iing;
using System.Text;
namespace ConsoleApplication22
{
= class Somethinglolo
{
= public void DoSumething() A
{ =
/7 Single dimensional array
int[ | numbers = new int[S];
/f Pultidimensional array
steing[,] names = new steing[s, 21;
/1 Array-of-arrays (jagged array)
byte[ ][] scores = new byte[5][ ];
/1 Ureate the jagged array
far (int 1 = 83 1 < scores.length; 1++)
scores[i] = new byte[i + 3];
/7 print length of each row
for (int i = 83 i ¢ scores.Length; it4)
{
Console.WriteLine("Length of row {0} is {1}", i, scores[i].Length);
le.Read();
I
}
H
100% =~ 4 4

Notice that it is a very sparse layout. The good news is that you can customize it any way you
want, to have quick access to the tools you need most. I'll add Server Explorer for now:

56 SomethingToDo.cs - Microsoft Visual Studio o s |
File Edt View Project Debug leam Data lools Architecture lest Anslyze Window Help

S % an - a0k |3 |G B

iz, Ry ae I 2083883 asl L)% % % 0 k2| B REEAF G = e,
Server bxplorer ~ 1 x f SomethingTeDo.cs X
A . -using system; |
+ [L.0ka Somnestons uedrg Systom.Callections Senerdc; :
{, PUBS MDF E > il

using System.Text;
Ty Servers L s
namespace ConsoleApplication22
1

class somethingrobe

{

public void Dosomething()
i

n

// Single dimensional array
int[] numbers - new int[5];

/7 wntidimensional array
string[,] names = new string[s, 4];

/1 Array-of-arroys (jagged array)
byte[ ][ | scores = new byte[S][ |5

// treate the jagged array
for (int 1 = @; 1 < scores.lengrh; 1+4)

scores[i] = new byte[i + 3];
£/ print length of each row
for (int 1= & i < scores.length; i+4)

Consele.riteLine("Length of row {8} Ls {1}", L, scores[i].Length);

Console.Read()

0% - ¢

If you make changes, they are saved to your .vssettings file when you close Visual Studio.

Remember that each mode is a distinct area, so the changes you make here are not seen in
any of the other window modes.
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Ax.36 Rearrange Your Toolbars

VERSIONS 2005, 2008, 2010
CODE vstipEnv0027

You can easily rearrange your toolbars by simply putting your mouse over the grip control
(the four vertical dots to the left of every toolbar), as shown in the following illustration:

[@-c-Cdd| s adl9
P A% | R oz | 54| ¢ ab | Table'
Gl [p s % (R0 | B R E

When you get the four-directional mouse pointer, just click and drag the toolbar to the new
position:

EB1 % % % k8| B REE
ﬁéﬂ'ﬂ'ﬁ.ﬂﬂhﬁ @9 -
_—-I'j'gljl—i :‘f|_-‘i|| ¥a|b|—|'ab|&‘\-riew

Be careful; it's real easy to get a shortened toolbar on your hands when moving toolbars be-
side other toolbars, as shown in the following illustration:

HEENE T I
_—-I'ﬂ'fﬂ]|—§:'f|d| i a|b|TabIr:
iﬂ%%mrﬁ'g‘%{_ﬂubwpqw

Note You know that you aren't seeing all the buttons on a toolbar if there are two arrows side-
by-side on the far right of that toolbar, as shown in the following illustration:

Bk
-

Of course, this shortened toolbar might be exactly what you want because the rest of the
buttons are accessed by clicking on the drop-down arrow:

E|ZE2|a83 -0
) 5 =l

Add or Remove Buttons -

SR % % |k k2l
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If this is not what you want, just click and drag the grip control of the toolbar to the right of
the shortened toolbar and uncover as many buttons as you like:

SR =™ - NP ERG SN I I =R S = G
P A% Roa | 55| ¢ alb | TableView~ | 5. |22 & |
iDRbLaElEE=Z2(000 0%

In Visual Studio 2008 and 2005, you can also make the toolbar a floating one by dragging it
off the toolbar area, as shown in the following illustration:

1£ras 15ual uehg

File Edit View Tools Window

To put it back, just double-click anywhere on the title bar of the toolbar.

AX.37

Create a Shortcut Key for a Macro

WINDOWS Alt, T, O
MENU Tools | Options | Environment | Keyboard
COMMAND Tools.CustomizeKeyboard
VERSIONS 2005, 2008, 2010
CODE vstipTool0066

We covered creating shortcuts in vstipTool0063 ("Keyboard Shortcuts: Creating New
Shortcuts,” page 127). Assuming you have a macro you would like to attach a shortcut key to,
you can easily make your macros accessible. Let's look at an example to show you how. First,
go to Tools | Options | Environment | Keyboard:

Options o )
4 Environment =] Apply the follawing addlitional keyboard mapping schema:
General W I(Ddauitl ,l I Reset |
Addein/Macras Security —
AutoRecover Show commands containing:
Documents

Extension Manager
Find and Replace
Fonts and Calors

Action Add
Action Add METFramewarkLaunchCandition D
Action AddAction

Import and Expert Settings Action AddDialog <
International Settings al i, '
[Keyboard Shortcuts for selected command;
Sartup [ | [ Remove
Task List
Web Brawser Use new shertcut in: Bress shartcut keys:
. Prajects and Salutians Global - [ Assign
+ Saurce Control B
+ Text Editar Shortcut currently used by
, Debugging .

> IntelliTrace
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To access your macros, type macros. in the Show Commands Containing area:

Show commands containing:

macros|

ity DecreaseTextEditorF ontSze

Macras.Samples.Accessibility IncreaseTextEditorFontSize N
Macros. Samples. Accessibility. MaximizeToolWindowsInEnvironment
Macros.Samples.Accessibility. ToggleTextEditorGrayScale 7
4 T |

In this case, let's bind the Macros.Samples.Utilities. TurnOffLineNumbers and Macros.Samples.
Utilities. TurnOnLineNumbers macros.

@ Warning Make sure the keyboard shortcuts you use here aren't already assigned to some-
thing else. They most likely aren't, but you should double-check by reviewing vstipTool0063,
“Keyboard Shortcuts Creating New Shortcuts,” page 127.

Shaw commands containing:

macros.samples.utilities.turn

Macras.Samples.Utilities. TurnOffWordWrap
Macros.Samples.Utilities. TurnOnLineMumbers
Macras.Samples.Utilities. TurnOnWardWrap

Let's bind Macros.Samples.Utilities.TurnOnLineNumbers to Ctrl+M, CTRL+1, as shown in the
following illustration:

Show commands containing:

macras.samples.utilities.turn

Macros.Samples.Utilities. TurnOffLineMumbers
Macros. Samples. Utilities, Turn OffW ardWrap
Macros.Samples.Utilities. TurnOnlineMumbers

Macros.Samples.Utilities. TurnOnWordWrap

Shortcuts for selected cormmand:

Eemaove

Use new shortcut in: Press shartcut keys:

| Global - | Ctlem Criel Assign

Let’s bind Macros.Samples.Utilities.TurnOffLineNumbers to Ctrl+M, Ctrl+0 (zero), as shown in
the following illustration:



Appendix B Additional Tips A73

Show commands containing:

macras.samples.utilities.turn

Macros.Samples. Utilities. TurnOffLineNumbers
Macros.Samples.Utilities. Turn OffWardWrap

Macros.Samples.Utilities. TurnOnLineMumbers
Macras.Samples.Utilities. TurnOnWordWrap

Shaortcuts for selected command:
Remove

Use new shortcut in: Bress shortcut keys:

Global - l Ctrl+M, Ctrl+0 Assign

Click OK, and let's test out our shortcuts. Go to any source code, and press Ctrl+M, Ctrl+0 to
turn line numbers off and Ctrl+M, Ctrl+1 to turn them on.

AX.38

How to Run External Executables from the Command Window

COMMAND Tools.Shell
VERSIONS 2005, 2008, 2010
CODE vstipTool0089

You can run external programs from the Command Window (Ctrl+Alt+A) by using the Tools.
Shell command. This can be useful if you run certain executables often (like Xcopy) and
want to turn the action into a command alias. See vstipTool0068 ("Understanding Command
Aliases,” page 113).

The general syntax for the command is as follows:

Tools.Shell [/command] [/output] [/dir:folder] path [args]

Arguments
Following are some key arguments you can use for this command:
e /commandwindow, /command, /c, or /cmd

Optional. Specifies that the output for the executable is displayed in the Command
Window.

e /dir:folder or /d: folder

Optional. Specifies the working directory to be set when the program is run.
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e /outputwindow, /output, /out, or /o

Optional. Specifies that the output for the executable is displayed in the Output
window.

For example, to run the Xcopy command, it would appear as shown in the following
illustration:

Command Window
>Tools.Shell fo fc xcopy.exe c:i\MyText.txt c:\Text'\MyText.txt

Just for fun, because | don't actually have the files in the sample command, the output shown
in the following illustration is the result of running the Xcopy command:

Cemmand Window

>Tools.Shell fo fc xcopy.exe ciiMyText.txt c:\Text\MyText.txt
File not found - MyText.txt

@ File(s) copied

#

As you can see, the output from Xcopy was redirected to the Command Window and tells me
that it can't find a file.

If the item you want to run isn't in the path environment variable, you must include the
full path (surrounded by quotes if any spaces are in the path), as shown in the following
illustration:

Command Window
*Tools.5hell "C:yvziptempi\Process Exploreri\procexp.exe™



Appendix B Additional Tips A75

Additional Tips from Chapter 4

Ax.39 Close All But This on the File Tab Channel
DEFAULT Alt+- (minus sign), A [VS2010 Only]
VISUAL BASIC 6 [no shortcut]
VISUAL C# 2005 Alt+- (minus sign), A [VS2010 Only]
VISUAL C++ 2 Alt+- (minus sign), A [VS2010 Only]
VISUAL C++ 6 Alt+- (minus sign), A [VS2010 Only]
VISUAL STUDIO 6 Alt+- (minus sign), A [VS2010 Only]
WINDOWS [no shortcut]
COMMAND File.CloseAllButThis; Window.ShowDockMenu
VERSIONS 2005, 2008, 2010
CODE vstipEnv0011
If you ever get the urge to close every file except the one you are currently working on, you
can just right-click the current file tab and choose Close All But This:
Generics.cs
H Save Generics.cs Ctrl+5
//Type Close Ctrl+Fa
- public
{ Close All But This
pro Copy Full Path
pre Open Containing Folder
Ax.40 Copy a File's Full Path from the File Tab

DEFAULT

VISUAL BASIC 6
VISUAL C# 2005
VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS
COMMAND
VERSIONS

CODE

Alt+- (minus sign), F [VS2010 Only]
[no shortcut]

Alt+- (minus sign), F [VS2010 Only]
Alt+- (minus sign), F [VS2010 Only]
Alt+- (minus sign), F [VS2010 Only]
Alt+- (minus sign), F [VS2010 Only]

[no shortcut]

File.CopyFullPath; Window.ShowDockMenu

2005, 2008, 2010
vstipEdit0013

You can quickly copy the full path of any file. Just right-click the tab for the file, and choose
Copy Full Path, as shown in the following illustration:
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Generics.cs X

H Save Generics.cs Ctrl+5
/iType paral Close Ctrl+F4
= public clas: .
1 Close All But This
protect Copy Full Path
protecte

Open Containing Folder

You now have the full path in your clipboard so that you can paste it (Ctrl+V) anywhere you
need it.

Ax.41 Understanding the File Tab Channel Drop-Down Button

VERSIONS 2005, 2008, 2010

CODE vstipEnv0012

Here is a convenient way to know whether you are seeing all your files on the File Tab
Channel.

Let's say you have a couple of files open: Notice that the button to the far right looks like an
arrow pointing down:

ReadMehtm ¢

But if you open up a few more files so that they all can't be seen on the file channel, the
button changes to let you know that all the files are not visible on the File Tab Channel (indi-
cated by the line above the arrow in the following illustration):

If you click the button, it gives you a list of all the files so that you can pick the one you want
from the list.
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How to Disable the IDE Navigator

DEFAULT

VISUAL BASIC 6
VISUAL C# 2005
VISUAL C++ 2
VISUAL C++ 6
VISUAL STUDIO 6
WINDOWS
COMMAND
VERSIONS

CODE

Ctrl+F6 (next); Ctrl+Shift+F6 (previous)

Ctrl+F6 (next); Ctrl+Shift+F6 (previous)

Ctrl+F6 (next); Ctrl+Shift+F6 (previous)

Ctrl+F6; Ctrl+Tab (next); Ctrl+Shift+F6; Ctrl+Shift+Tab (previous)
Ctrl+F6 (next); Ctrl+Shift+F6 (previous)

Ctrl+F6; Ctrl+Tab (next); Ctrl+Shift+F6; Ctrl+Shift+Tab (previous)

[no shortcut]

Window.NextDocumentWindow; Window.PreviousDocumentWindow
2005, 2008, 2010

vstipEnv0039

By default, if you press Ctrl+Tab, you get the IDE Navigator, as shown in the following

illustration:

=] MsaaVerifyForm.vh

Visual Basic Source file

Active Tool Windows
£ Salution Explorer
1 Properties

4 Server Explarer
s+ Toalbax

_"d Errar List

=] Output

Active Files

18] NativeMethods.vb

=] MsaaVerifyFarm.yh

@ HelpVerifications.vb [Design]
2] Exceptions.vb

] AssemblyInfa.vh

8] AccessibleObject.vb

=] Find Results 1 ] Operations.vh

&2 Find Symbol Results Eﬁ MsaaVerify

] Command Windaow =] MsaaVerifyFarm.vb [Design]
=] HelpVerifications.vb
Start Page

DiDacuments'Visual Studio 2010 Projects' MsaaVenfySource'\ MsaaVerifyFarm.vh

Some people don't like this feature and instead would like to just iterate through open docu-
ment tabs.

This behavior is bound to Ctrl+ F6 and to Ctrl+Shift+F6 in the General settings, but some
people don't like this key combination.

You can easily rebind the commands to Ctrl+Tab and Ctrl+Shift+Tab. If you go to
Tools | Options | Environment | Keyboard, you can see that Ctrl+Tab is bound to
Window.NextDocumentWindowNav:



A78 AX.42 How to Disable the IDE Navigator

Use new sharteut in: Press shartcut keys:

| Glabal - | Ctul+Tab [ Asign |

Shortcut currently used by:

| Window NextDocumentWindawNav (Ctrl+Tab (Global)) v

If you assign Ctrl+Tab to Window.NextDocumentWindow instead, you can see the result in
the following illustration:

Show commands cantaining:

window.nextdocumentwindow|

Window.NextDocumentWindow
Window.MextDaocumentWindowhav

Shortcuts for selected command:
| Ctrl +F6 {Global) - |

Remave l

Use new shartcut in: Press shortcut keys:

| Glabal +| Ctrl+Tab Assign

Shaortcut currently used by:

| Window.NextDocumentWindowlay {Ctil+Tab (Global) -

The IDE Navigator does not show up anymore, and instead Ctrl+Tab iterates through the

open document tabs. If you like this, you might want to bind Ctrl+Shift+Tab to Window.
PreviousDocumentWindow as well:

Show commands containing:

Window.previousdocumentwindow

Window.PreviousDocumentWindow
Window.PreviousDocumentWindowlMav

Shortcuts for selected command:

| Ctrl+Shift +F6 (Global) -] |

Remaove l

Use new shartcut in: Press shartcut keys:

| Glabal »| | Ctrl+Shife+Tab | Assign |

Shartcut currently used by:

| Window PreviousDacumentWindowhay (Ctrl+Shift+Tab {Glabal) -
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If you don't like the new setup, you can always reverse the process and rebind
Ctrl+Tab and Ctrl+Shift+Tab to Window.NextDocumentWindowNav and Window.
PreviousDocumentWindowNav, respectively.

For more information about binding keyboard shortcuts, refer to vstipTool0063 (“Keyboard
Shortcuts Creating New Shortcuts,” page 127).

AX.43

Thumbnail Previews in the IDE Navigator

VERSIONS 2010
CODE vstipTool0113

In vstipTool0023 (“Using the IDE Navigator,” page 160), | show you how to use the IDE
Navigator. This next tip comes from Paul Harrington on the Visual Studio Team. In Visual
Studio 2008, when you used the IDE Navigator, you could also see thumbnail previews of the
documents in the list. However, this feature was removed from Visual Studio 2010. The good
news is that the feature is still there.

Warning This tip requires you to add a value to the registry, so you do this at your own risk.
And this solution has been known to not always work 100 percent of the time.

Open up the registry (regedit.exe), and go to HKEY_CURRENT_USER\Software\Microsoft\
VisualStudio\10.0\General.

Now right-click the General key, and add a new DWORD value:

[ —

- . FontAndColars

o = I ‘ ‘ 74| AllowDeferredSavePrajects  REG_DWORD
> gl e toAddSalutionTaSCC REG_DWORD
bl HT] Expand L e nre rasanp
so 0 Im Mlew 9 Key D
----- . Kes .

..... . la e String Value D
> -0 La Delete Binary Value g
""" . flz-lo Rename DWORD {32-bit) Value D
..... | Mes .

L Ne Export QWORD (64-bit) Value D
..... | Mes Permissians... Multi-String Value 0]
..... . Ob Expandable String Value D
----- , Ohb Copy Key Name feumentUGaekPTererence  REG_DWORD

Call it ShowThumbnailsOnNavigation, and set the value to 1:

ol S